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Accessing Microsoft PowerPoint  

To access Microsoft PowerPoint from your home computer, you will probably either use 
the Start menu to select the program or double-click on an icon on the Desktop.  

To open Microsoft PowerPoint 
2002 from the computers in the      
computer lab at the library, 
simply click once on this button.  

Anatomy of a PowerPoint Window  

When you open up Microsoft PowerPoint 2002, the window should look like this:  

 
I nt roduct ion  

to Pow erPoint
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Creating a New Presentation  

When you first open Microsoft PowerPoint, a new, blank presentation will automatically 
be created.  To create another new, blank presentation, follow these steps:  

  

A blank presentation allows you to create a PowerPoint presentation from scratch.  You 
can still choose to insert slides with preset layouts, but you have to change fonts, 
background and text colors, and other text attributes like alignment and style yourself.  

Design Templates  

You can also create a new presentation using a design 
template, which provides a uniform color scheme and 
slide layout for the entire presentation.  

Instead of choosing  as described above in 
Step 2, click on the option directly below it, which is 

.  This will bring up the Slide Design 
task pane, shown on the right.  You will see a list of 
thumbnails, which are smaller images that allow you to 
preview what the design templates look like.  

To apply one of these design templates to your new 
presentation, simply click on its thumbnail.  

HINT: You can also apply a design template to a blank 
presentation or change the design template you first 
selected by choosing Slide Design from the Format 
menu.  You can do this at any time.
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Working with Slides  

PowerPoint presentations are made up of slides, each of which contains a portion of 
the material you re presenting in an order you specify.  Slides can contain text, images, 
charts, graphs, links to Web sites, animation, audio, and video.  

Inserting New Slides  

When you create a new presentation, you are automatically provided 
with your first slide.  In Microsoft PowerPoint 2002, this first slide is a 
Title Slide, shown on the right, which provides spaces for a title and a 
subtitle.  These spaces are called placeholders.

  

To insert a new slide into your presentation, follow these steps:  

  

Microsoft PowerPoint provides a number of preset slide layouts to choose from, all of 
which can be modified to fit your exact needs.  A layout determines how text, images, 
and other objects are positioned on the slide.  

Text Layouts   

        

 Title Slide         Title Only   

       

       Title and Text      Title and 2-Column Text 

 

The default layout for the 
first slide of a presentation. 
Contains placeholders for a 
title and subtitle. 

 

Only contains a placeholder 
for a title.  Use when you want 
to create a title slide with your 
own customized layout. 

 

Contains placeholders for a 
title and a bulleted list of text.  
Use this layout when the items 
in your list are long. 

 

Placeholders for a title and 2 
bulleted lists, for when you have 
a list of 4 or more short items. 
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Content Layouts   

       
    Blank        Content     

       

     Title and Content       Title and 2 Content  

Text and Content Layouts   

       

 Title, Text and Content    Title, Text and 2 Content   

       

Title and Text over Content        Title and 2 Content over Text  

When choosing which layout to use, pick the layout that will best communicate the 
points you are trying to make to your audience usually the simplest.  

Editing Slides  

Once you choose the slide layout you want to use, you need to edit the slide to add 
text, graphics, and other objects.  

1. To add text to a title or bulleted list placeholder, like 

, simply click within the placeholder 
and start typing.  Press the Enter key to move to the 
next line in a bulleted list.  Once you ve added the text 
you want, click outside of the placeholder to deselect it.  

2. To add content to a content placeholder, click on one of 
the icons within the placeholder: 

 

 Insert Table  

 

 Insert Chart  

 

 Insert Clip Art  

 

 Insert Picture  

 

 Insert Diagram 

 

 Insert Media Clip  

When you click on the Insert Clip Art icon, you will see the Select Picture dialog box, 
shown above to the right, which you can use to search for clip art by keyword. 

 
This layout doesn t contain 

any placeholders and allows 
you to work completely from 
scratch. 

 
Contains one placeholder 

for a table, chart, clip art, 
picture, or media clip.  Use for 
large, important graphics. 

 

Includes placeholders for a 
title and one table, chart, clip 
art, picture, etc. 

 

This layout allows you to 
place a title over 2 types of 
content (same or different). 

 

Use this layout to place a 
title over a bulleted list next to 
a picture, table, clip art, etc. 

 

Allows you to place a title 
over a several-item bulleted list 
placed over a type of content. 

 

Includes placeholders for a title 
over a bulleted list to the left and 2 
types of content to the right. 

 

Place a title over 2 types of 
content, with a several-item 
bulleted list underneath. 
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To further edit your slides and customize them to best fit your information, text and 
content placeholders can be resized and moved on the slide, as described below: 

  

HINT: If you want to maintain the proportions of a text or content placeholder, make 
sure you click and drag on one of the corner handles.  This will lengthen or shorten the 
placeholder horizontally and vertically at the same time.  

Duplicating a Slide  

You might want to insert a duplicate of a slide you ve already created because you want 
to use the same slide twice or because you want to use the exact same layout for 
another slide.  To insert a duplicate slide into your presentation, follow these steps:  

  

Deleting a Slide  

To delete a slide from your presentation, simply click on the slide in the Slides View task 
pane on the left-hand side of the window like you do for duplicating a slide, then press 
the Delete key on the keyboard. 

The duplicate slide will 
appear in the Slides 
View task pane directly 
after the selected slide.  

You can move the 
duplicate slide to 
another position in the 
presentation using the 
Slide Sorter view (as 
discussed below). 
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Slide Sorter  

Microsoft PowerPoint s Slide Sorter view allows you to view multiple slides at the same 
time and is useful for getting a picture of your presentation as a whole.  You can use 
the Slide Sorter to easily rearrange the order of slides in your presentation.  You can 
also delete slides while using this view.  

To switch to Slide Sorter view, choose Slide Sorter from 
the View menu, as shown to the right.  

When you are using the Slide Sorter view, the PowerPoint 
window will look like the illustration below:  

  

NOTE: You cannot edit slides when using the Slide Sorter view.  To return to the 
Normal view, choose Normal from the View menu.  

Viewing the Presentation  

To see how your presentation looks at full screen and preview how it will 
look to your audience, choose Slide Show from the View menu, as 
shown on the right.  Once the presentation expands to full screen, you 
can move from slide to slide using the mouse or keyboard:  

Advance  Mouse click, Page Down key, Enter key, or Down Arrow key  
Go Back  Page Up key, Backspace key, or Up Arrow key  

To end the presentation, press the Esc key or double click on the last slide.  

HINT: When you view the presentation using this method, the first slide displayed at full screen will 
be whatever slide is currently displayed in Normal view.  To start the presentation from the 
beginning no matter which slide is currently displayed in Normal view, select View Show from the 
Slide Show menu. 

To move a slide to another spot 
in the presentation, click on the 
slide and drag it to the new 
location.  

To delete a slide when using the 
Slide Sorter view, click on the 
slide to select it and press the 
Delete key on your keyboard. 
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Printing Handouts  

Some presenters like to use Microsoft PowerPoint to print handouts for their audience.  
These handouts contain small versions of slides and, if you choose, a space for 
audience members to make notes.  You can also print your presentation in handout 
form for your own use as a presenter.  

Follow these steps to print handouts:        

I f you re printing handouts with four or more slides, you ll 
also need to choose whether the slides will be printed in 
order horizontally or vertically, as shown to the right. 

NOTE: When you want to print handouts, make 
sure you re choosing the Print command from 
the File menu.  If you use the Print icon ( ) on 
the Standard toolbar, you will automatically get 
one big slide per page. 
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Glossary of Terms  

Alignment The position of text or objects on the slide.  Text and objects can 
be aligned to the right-hand side of the slide or the left-hand side 
of the slide, as well as centered in the middle of the slide.  

Border A line or design that can be placed around text boxes, tables, or 
images on a slide.  

Bullet A distinguishing character placed in front of items in a list.  

Clip Art A set of images that comes with Microsoft PowerPoint.  These 
images are keyword searchable and can be inserted into slides.  

Clipboard A place where text and objects are temporarily placed after being 
cut or copied so that they can then be pasted where desired.  

Copy A command that allows you to make an exact copy of selected text 
or objects to be placed on another slide within the same 
presentation or on any slide within another presentation.  

Cut A command that allows you to remove selected text or objects from 
a slide so that you can place it on a different slide within the same 
presentation or on any slide within another presentation.  

Default A predefined setting that is built into a program and will be present 
each time that program is run unless an alternative setting is 
specified.  

Edit To add, delete, or change information (text, images, tables, etc.) 
on a slide.  

File Name The name assigned to a presentation either automatically by the 
computer or by the user when saved.  

Font The visual design of characters.  Also called a typeface.

  

Format The way text and objects appear on a slide.  

Paste A command that allows you to insert cut or copied text or objects 
into a slide.  

Point Size The height of a character.  72 points = 1 inch.  
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Rename To change the name of a saved presentation.  

Shortcut Menus that appear when an object or text is right-clicked with the 
Menus mouse.  They allow you to perform common functions more 

quickly.  

Template A special kind of slide that produces new slides with a preset 
format.  A template can control colors, fonts, bullet types, 
backgrounds, and graphics.  

Text Box An object, which usually contains text, that is inserted into a slide.  
Templates often contain premade text boxes.  

Transition The movement from one slide to another in a presentation.  
Animated transitions create a distinctive visual effect when 
advancing to the next slide.  

Wizard A tool that guides you through a task in a series of easy-to-follow 
steps.  

WordArt Decorative text created using the Drawing Toolbar.   

Further Reading Suggestions  

These books, available from the library, will help you learn more about the various 
versions of Microsoft PowerPoint and how to use them.  The version of PowerPoint used 
at the library, Microsoft PowerPoint 2002, may be different than the version you use on 
other computers at home, work, or school.  

Microsoft PowerPoint 97  

Sams Teach Yourself PowerPoint 97 in 10 Minutes  by Faithe Wempen  

Microsoft PowerPoint 2000  

PowerPoint 2000  by Rachel Kirk 
Learning PowerPoint 2000: Beginning, Intermediate, and Advanced  (video series) 
PowerPoint 2000: Beginning  (CD-ROM)  

Microsoft PowerPoint 2002  

How to Do Everything with PowerPoint 2002  by Ellen Finkelstein  

Microsoft PowerPoint 2003  

Creating a Presentation in PowerPoint  by Tom Negrino 


